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New Features

The following new features have been added in version 8.5.0 of TIBCO ActiveMatrix BusinessWorks™ Plug-
in for SAP Solutions.

e The plug-in now supports the below features without the need for messaging, i.e. TIBCO Enterprise
Message Service or Apache Kafka.

¢ IDoc Listener Activity
Receiving IDocs from SAP System.

* New Activity: IDoc Converter
The IDoc Converter activity is added to the SAP palette.
Converting Raw IDoc to XML output.

e PostIDoc to SAP Activity
Confirmation of IDoc following posting of IDoc to SAP system.

o TIDManager Shared Resource

¢ This release adds support for the following databases for TIDManager Shared Resource:

Database Versions

MySQL Database 5.7.x and 8.x
MS SQL Server 2019

Oracle Database 18c and 19¢
PostgreSQL 12.x

¢ The TIDManager Shared Resource now supports Data Direct JDBC drivers included in TIBCO
ActiveMatrix BusinessWorks™
o Migrating ActiveMatrix BusinessWorks'" 6.x Adapter Projects and AE Palette Projects

You can migrate ActiveMatrix BusinessWorks 6.x projects that contain SAP Adapter Configurations and
processes with references to AE Palettes to TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP
Solutions.

The following Adapter Services can be migrated to plug-in activities:

¢ Publication Service
e Subscription Service
¢ Request Response Service

¢ Request Response Invocation Service

The following databases are used for TIDManager Shared Resource as part of migration:

e MS SQL Server

e Oracle Database
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Support for SAP S/4AHANA
The plug-in supports the following versions for SAP S/4AHANA:

e 2020 (On-Premise version only)
o HANA Enterprise Cloud

— 1709 HEC
— 1809 HEC
— 1909 HEC
— 2020 HEC

Support for SAP BW/4AHANA 2.x (ODP or RFC only)
The plug-in supports SAP BW/4HANA 2.x (ODP or RFC only)

Support for SAP Solution Manager 7.2.x (RFC only)
The plug-in supports SAP Solution Manager 7.2.x (RFC only)

Support for TIBCO ActiveMatrix BusinessWorks" 6.7.x
The plug-in supports TIBCO ActiveMatrix BusinessWorks™ 6.7.x

Support for TIBCO BusinessWorks" Container Edition 2.6.x
The plug-in supports TIBCO BusinessWorks™ Container Edition 2.6.x
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Changes in Platform Support

The following table lists the changes in platform support in version 8.5.0 of ActiveMatrix BusinessWorks™
Plug-in for SAP Solutions. For a complete list of all the currently supported platforms, see the readme file.

Platform Status As of Release  Notes
Apple Mac OS X 10.11.x, 10.12.x on x86-64 Dropped 8.5.0

Novell SUSE Linux Enterprise Server 11.x on Dropped 8.5.0

x86-64

Red HAT Enterprise Linux Server 6.x 64-bit on Dropped 8.5.0

x86-64

Red HAT Enterprise Linux Server 8.x 64-bit on Added 8.5.0

x86-64
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Changes in Functionality

The following are the changes in functionality in version 8.5.0 of ActiveMatrix BusinessWorks Plug-in for
SAP Solutions.

e When using the Dynamic Connection activity, if the connection is unable to be established due to invalid
password then the plug-in does not automatically re-connect and displays the TIBCO-BW-SR-
SAPCONNECTION-501001 error code.

& To enable this change and receive the different error and message code, set the Java property
com.tibco.bw.palette.sap.clientLogonError.disableReconnect to true.

*  When using the Post Doc to SAP activity, the CPIC ID attribute available on the output is only populated
in case of Dynamic Connection.

*  When using the below plug-in activities in a ActiveMatrix BusinessWorks process, the SAP Schema is no
longer inline and is now a reference
— IDoc Renderer activity
— Post IDoc to SAP activity
— Reply from RFC/BAPI in SAP activity

For the existing inline schema activities mentioned above, it is possible to execute them as they

& are in ActiveMatrix BusinessWorks Plug-in for SAP Solutions 8.5.0. However, if you refresh the
schema for those existing inline schema activities, then a manual fix in the mapping for those
activities is required.

e Post IDoc to SAP activity

When selecting IDoc Confirmation mode, if the mode is changed to None or NoMessaging from JMS,
then the JMS Connection process property created automatically must be deleted manually
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Deprecated and Removed Features

The following are the deprecated and removed features in version 8.5.0 of ActiveMatrix BusinessWorks
Plug-in for SAP Solutions.

Deprecated Features

Release 8.5.0

e Support for migration of ActiveMatrix BusinessWorks 6.x Adapter Projects and AE Palette Projects.
o TIBCO Adapter Framework 1.6.0 -1.6.x

e Support for IBM AIX 7.1, 7.2 64-bit on pSeries (Runtime only)

e Support for Oracle Solaris 11 64-bit on SPARC (Runtime only)

o Support for Oracle Solaris 11 64-bit on x86-64 (Runtime only)

Removed Features

Release 8.5.0

e SAP]JCo 3.0.x libraries

e SAP NetWeaver BW or BI 7.0-7.5 (ODS or REC only)

e SAP S/4HANA 1511 and 1610

e MSSQL Server 2008 R2 for TIDManager Shared Resource

e Oracle Database 11g 11.1.x and 11.2.x for TIDManager Shared Resource
o TIBCO Enterprise Message Service 8.0, 8.1, 8.2, 8.3, 8.4, and 8.5.0
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Migration and Compatibility

The following instructions explain how to migrate projects to version 8.5.0 of ActiveMatrix BusinessWorks
Plug-in for SAP Solutions from an earlier version.

You can migrate projects from version 8.3.0 or 8.4.0 to version 8.5.0 of ActiveMatrix BusinessWorks
Plug-in for SAP Solutions in TIBCO Business Studio™ for BusinessWorks™.

If you want to migrate projects that have been created in a version earlier than version 8.3.0, you must
first migrate the project to version 8.3.0 and then perform the procedure to migrate the projects.

Migrating Projects from Version 8.3.0 or 8.4.0 to Version 8.5.0

1.

AR

In TIBCO Business Studio, export the projects created in version 8.3.0 or 8.4.0 to a local disk.

From the menu, click File > Export.
b. In the Export dialog box, expand General, select Studio Projects to Archive, and then click Next.

c. Inthe Export Project dialog box, select the projects that you want to export and specify export
<path>/<destination> in the To Archive File field.

d. Click Finish to export the selected projects.

Uninstall ActiveMatrix BusinessWorks Plug-in for SAP Solutions 8.3.0 or 8.4.0.
Install TIBCO ActiveMatrix BusinessWorks Plug-in for SAP Solutions 8.5.0.
Start TIBCO Business Studio and create a workspace.

In the workspace, import the previously exported projects.

From the menu, click File > Import.

b. Inthe Import dialog box, expand General, select Existing Studio Projects into Workspace and then
click Next.

c. Inthe Import Projects dialog box, click Browse next to the Select archive file field to select the
projects that you want to import.

When importing an existing project to the current workspace of TIBCO Business Studio™,
& if you click Select root directory in the Import Projects dialog, you must select the Copy
projects into workspace check box.

d. Click Finish.

Perform the following operations to refactor the imported projects:

Right-click the project and click Refactor > Repair BusinessWorks Projects.

b. In the Repair BusinessWorks Projects dialog box, ensure that the Upgrade SAP Plugin
Configuration to Current Version check box is selected.

c. Click OK.

For more details about the import and export procedures, see the ActiveMatrix
BusinessWorksdocumentation.

Migrating projects from version 7.2.1 of TIBCO ActiveMatrix® Adapter for SAP

To support adapter to plug-in migration, perform the following steps:

1.

Install ActiveMatrix BusinessWorks or TIBCO BusinessWorks™ Container Edition
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Install TIBCO ActiveMatrix® Adapter Migration
Install ActiveMatrix BusinessWorks Plug-in for SAP Solutions 8.5.0

®

Refer to the readme for compatible versions on any dependent products for step 1 and 2.

The migration of ActiveMatrix BusinessWorks 5.x projects saved as design-time libraries is not
supported.

To migrate projects created in version 7.2.1 of TIBCO ActiveMatrix® Adapter for SAP:

1. Click Project > Migrate BW Projects.

2. In the BW Project Migration window, select the ActiveMatrix BusinessWorks 5.x project to be migrated
and the migrated project folder, and then click Migrate.

For more information about migration, see "Migrating Projects” in the TIBCO ActiveMatrix BusinessWorks™
Plug-in for SAP Solutions User's Guide.

For more details about the import and export procedures, see the ActiveMatrix
BusinessWorksdocumentation.

EAR file Compatibility From Version 8.3.0 or 8.4.0 to 8.5.0

The ActiveMatrix BusinessWorks Plug-in for SAP Solutions 8.5.0 allows the compatibility of EAR files
created from the version 8.3.0 or 8.4.0.

If you are using an EAR file from 8.3.0 or 8.4.0 using a new appspace and appnode then you are only
required to redeploy the EAR file.

If you are using an EAR file from 8.3.0 or 8.4.0 using an existing appspace and appnode then below steps
are required.

Shut down any appnodes running ActiveMatrix BusinessWorks Plug-in for SAP Solutions applications.
Uninstall ActiveMatrix BusinessWorks Plug-in for SAP Solutions 8.3.0 or 8.4.0.

Install ActiveMatrix BusinessWorks Plug-in for SAP Solutions 8.5.0.

L e

After the successful installation of version 8.5.0, set the
bw.appnode.clean.config.folder.on.startup property as true in the config.ini file for appnode.

5. Restart any required appnodes.
TIBCO BusinessWorks Container Edition™ (BWCE) Compatibility from Version 8.3.0 or 8.4.0 to 8.5.0
Design time:

To migrate a project from a version 8.3.0 or 8.4.0 to version 8.5.0, import the project created using the
version 8.3.0 or 8.4.0 directly to a TIBCO BusinessWorks Container Edition environment having the version
8.5.0.

Run time:

EAR Generated in 8.3.0 or 8.4.0 can be directly used in 8.5.0.

Updating the SAP JCo libraries

In version 8.5.0, you do not have to uninstall and then reinstall the plug-in to upgrade SAP JCo libraries.
For more information about updating SAP JCo libraries, see the "Updating SAP JCo Libraries" section in the
TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions Installation Guide.

Migrating ActiveMatrix BusinessWorks Plug-in for SAP Solutions 8.5.x to TIBCO ActiveMatrix
BusinessWorks"™ Plug-in for OData Services for SAP S/4HANA 6.2.1-6.2.x projects

For more information about migrating ActiveMatrix BusinessWorks Plug-in for SAP Solutions 8.5.x to
ActiveMatrix BusinessWorks Plug-in for OData Services for SAP S/4AHANA 6.2.1-6.2.x projects, see
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"Migrating projects from SAP ECC to SAP S/AHANA" in the TIBCO ActiveMatrix BusinessWorks™ Plug-in for
SAP Solutions User's Guide.
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The table lists closed issues in version 8.5.0 of TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP

Solutions.

Key

SAPB-2547

Summary

When the IDoc Listener activity receives an IDoc data where the SDATA contains an
EOL character, the raw IDoc data placed in the JMS queue is not correct.

If the IDoc data contains one or more EOL characters then the Java property
com.tibco.bw.palette.sap. IDocCustomDelimiter must be specified. The value of
the Java property is of type string and is printed after each IDoc data segment as part
of the raw IDoc placed in the JMS queue.

If the com. tibco.bw.palette.sap. IDocCustomDelimiter Java property is set, then
the com.tibco.bw.palette.sap.escapeEOLCharacters Java property should not be
set.

SAPB-2393

The IDoc Parser activity does not throw an error if the IDoc data has invalid
characters.

If the acknowledge mode is set to Client, a new event is generated so that event
context is available for the Confirm activity to confirm the message. If acknowledge
mode is set to Auto, the IDoc Parser Fault is generated.

SAPB-2345

The Post IDoc to SAP activity generates a timeout error while processing significant
number of IDocs.

SAPB-2308

After fetching and refreshing the RFC schema in the Invoke RFC BAPI for SAP activity,
the schema does not get updated in the process even though it is already updated in
the SAP system.

SAPB-1912

The active mode in SAP TIDManager shared resource does not work in TIBCO
BusinessWorks™ Container Edition.

SAPB-978

When importing a project created in version 8.1.1 to version 8.2.0, if the project
contains the IDoc Reader and Invoke RFC/BAPI in SAP activities then the output
schema does not reflect 8.2.0 configuration.
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The table lists known issues in version 8.5.0 of TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP

Solutions.

Key

SAPB-2729

Summary

Summary: After TIBCO ActiveMatrix BusinessWorks™ 5.x Adapter to Plug-in
migration, the Input tab in the Respond to Adapter Request activity is empty.

Workaround: After migration, delete the Reply from RFC BAPI in SAP activity and re-
add the activity, and then select the value for Reply For field in the General Tab.

SAPB-2643

Summary: When refactoring TIBCO ActiveMatrix BusinessWorks™ 6.x projects that
contains the ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions activities to
TIBCO ActiveMatrix BusinessWorks™ Plug-in for OData Services for SAP S/4HANA
activities, the mapper activity in the refactored project results in an unresolved
reference to input schema.

Workaround: Make changes to the activity to enable the save to autocorrect the
reference.

SAPB-2621

Summary: After migrating a TIBCO ActiveMatrix® Adapter for SAP 5.x or 6.x
configuration to a ActiveMatrix BusinessWorks™ project containing ActiveMatrix
BusinessWorks Plug-in for SAP Solutions activities, any test SAP client connections
fail.

Workaround: Prior to adding the test connection in SAP Adapter configuration,
migrate all required ActiveMatrix® Adapter for SAP 5.x or 6.x configurations to a
ActiveMatrix BusinessWorks project and then restart TIBCO Business Studio™ for
BusinessWorks™.

SAPB-2337

Summary: While starting ActiveMatrix BusinessWorks application where current
status is STARTFAILED in bwadmin, the application is unable to start successfully.

Workaround: Restart the corresponding appnode or confirm fix for AMBW-40039 is
available in the ActiveMatrix BusinessWorks release being used.

SAPB-2318

Summary: For Adapter to Plug-in migration, when the ActiveMatrix BusinessWorks
5.x process contains the AE Palette activity, Invoke an Adapter Request-Response
service and the ActiveMatrix BusinessWorks 6.x workspace is new, a migration error is
observed due to references to the Invoke REC/BAPI in SAP activity instead of the
added mapper activity.

Workaround: Delete the migration project from workspace and perform the migration
steps again.

SAPB-2277

Summary: When migrating from SAP ECC to SAPS/4HANA, if the SAP project has
multiple InvokeRFCBAPI activities that have the same schema, the configuration in the
JSON preference file is applied to all the selected InvokeRFCBAPI activities in the
project that are using that schema.

Workaround: None
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SAPB-2058
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Summary

Summary: When selecting the messaging source from SAP connection resource, user is
able to configure different MessageSource in IDocListener activity and SAPConnection
Resource.

Workaround: MessageSource from both IDocListener and SAPConnection should be
in sync with each other.

SAPB-2052

Summary: When the IDocListener activity is executed for the first time on Kafka, and
if the Kafka properties are left blank, an error occurs.

Workaround: Give any property from Kafka or add the key:value pair and execute.
Then remove the property and it will not throw any error if Kafka Properties field is
empty.

SAPB-2042

Summary: When multiple bootstrap servers are provided, only the last entry is
validated.

Workaround: None

SAPB-1905

Summary: When we change any module property in TEA for the deployed application
and on the start of the application errors occur in log but application starts.

Workaround: Stop the application in TEA and update the module property
SAPPassword and start the application again. It will start without any errors.

SAPB-1801

Summary: When a new mapper activity is added to the existing process, after
importing the extracted projects to a workspace with Copy projects into workspace
option, you cannot view the previously fetched input schemas list to map to 'mapper’.

Workaround: One of the following workaround's can be used.

¢ Use Refresh API button in connection resource to re-fetch the schema.

e When importing projects, do not select Copy projects into workspace option.

SAPB-1737

Summary: While using the tRFC invocation protocol, when a fault is captured, the
input data on the Invoke RFC/BAPI in SAP activity is not available as part of the fault
job.

Workaround: None

SAPB-1596

Summary: Migration of an AE activity (Invoke an Adapter Request-Response service)
that does not have an adapter service mapped, is not supported.

Workaround: None

SAPB-1468

Summary: Migrating a project that has a request response and request response
invocation service generates a not valid BPEL import error.

Workaround: Click the Process > Dependencies tab and remove the import causing
the error.

SAPB-1384

Summary: After migration, the setting of the language code "A" in the JSON file is
migrated to Afrikaans. It must be Arabic.

Workaround: Select Afrikaans or Arabic manually.
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Key Summary
SAPB-1339 Summary: The installation of Adapter to Plugin Migration feature fails with P2
installation.

Workaround: Install P2 using TIBCO Universal Installer and select the Adapter to
Plugin Migration installation profile.

SAPB-1333 Summary: After migration, the XSLT is out of sync error occurs.
Workaround: Right-click the input mapping and select Show Check and Repair.

SAPB-1260 Summary: During migration of the schemas from ActiveMatrix BusinessWorks 5.x
project, the Table Type field is optional even though it is required for mapping after
migration.

Workaround: Manually add the value for the field.

SAPB-1237 Summary: After migrating Respond to Adapter Request activity of ActiveMatrix®
Adapter for SAP, the processStarterResponse input element shows duplicate values.

Workaround: Select Show Check and Repair and manually fix the error.

SAPB-1163 Summary: Upgrade to a later plug-in version does not work.
Workaround: Uninstall the existing version of the plug-in and then install the later
version.

SAPB-1154 Summary: During configuration of the IDoc Acknowledgment activity, the <any

element> appears in the Fault schema.

Workaround: <any element> should not be used and ignored.

SAPB-1136 Summary: If an error occurs when connecting to the IDoc Confirmation JMS Queue
and IDoc confirmation mode is set to JMS, then in the Post IDoc to SAP activity the
IDoc is not available in the fault data.

Workaround: None

SAPB-1032 Summary: If the Receive IDoc Destination JMS queue contains a message before the
IDoc Parser activity starts, the messages are not processed concurrently based on the
JMS maxSessions configuration.

Workaround: None

SAPB-849 Summary: When invoking an RFC/BAPI in the SAP system as part of a transaction by
using a connection created by the Dynamic Connection activity, if a specified context
timeout occurs, the return from the SAP system fails.

Workaround: Change the value of the contextTimeout input item in the Dynamic
Connection activity to avoid the timeout.

SAPB-753 Summary: When using the SNC connection type for the Dynamic Connection activity,
the usage of Single-Sign-On (SSO) and X.509 certificates does not work.

Workaround: None.
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SAPB-739
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Summary

Summary: When the IDoc Parser and IDoc Reader activities are processing messages,
if an EMS server restarts, duplicate messages are processed.

Workaround: None

SAPB-710

Summary: The connections created by the Dynamic Connection activity cannot be
cloned.

Workaround: When creating a dynamic connection, specify the connection parameters
in the input schema of the Dynamic Connection activity.

SAPB-654

Summary: The Dynamic Connection activity used for transactions does not work.

Workaround: Use the SAP Connection shared resource.

SAPB-588

Summary: When changing the SAP Connecting shared resource name for the IDoc
Parser and IDoc Reader activities, the values of the properties related to this shared
resource are incorrect.

Workaround: After selecting the different SAP Connection shared resource, download
the appropriate SAP IDoc schema again.

SAPB-577

Summary: When starting an application, if the processes associated with the
application contain multiple IDoc Parser, IDoc Reader, or Post IDoc activities
referencing the same SAP IDoc message, an exception occurs.

Workaround: Create a separate application for each occurrence.

SAPB-512

Summary: When Oracle Database is used for the SAP TIDManager shared resource
and the database exists in the environment where ActiveMatrix BusinessWorks exists,
if the database connectivity is disrupted, the plug-in does not reconnect to the
database.

Workaround: Install Oracle Database in an environment where ActiveMatrix
BusinessWorks is not installed.

SAPB-510

Summary: When posting IDocs to the SAP system by using only one ActiveMatrix
BusinessWorks engine, the actual number of messages processed concurrently is
different from the value configured in the Max Session field of the IDoc Reader
activity.

Workaround: Use multiple ActiveMatrix BusinessWorks engines to post IDocs to the
SAP system.

SAPB-480

Summary: The IDoc Confirmation, IDoc Parser, and IDoc Reader activities are not
compatible with the startprocessstarters and stopprocessstarters commands
of the bwadmin utility.

Workaround: None.

SAPB-263

Summary: When running an ActiveMatrix BusinessWorks project containing the IDoc
Listener and RFC BAPI Listener activities, if the activities use the same SAP
Connection shared resource, the following exception might occur:

Error Message: check TID fault: No transaction handler is installed.
Unable to process tRFC/QRFC requests

Workaround: Put the IDoc Listener and RFC BAPI Listener activities into two projects.
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Key Summary

SAPB-223 Summary: The DECF16 and DECF34 data types are not supported.
Workaround: None.

SAPB-51 Summary: The SAP Connection shared resource cannot be renamed.

Workaround: None.
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TIBCO Documentation and Support Services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly in
HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current than any other
documentation included with the product.

Product-Specific Documentation

The following documents for this product are available on the TIBCO ActiveMatrix BusinessWorks™ Plug-
in for SAP Solutions page.

o TIBCO ActiveMatrix BusinessWorks Plug-in for SAP Solutions Release Notes

o TIBCO ActiveMatrix BusinessWorks Plug-in for SAP Solutions Installation

o TIBCO ActiveMatrix BusinessWorks Plug-in for SAP Solutions User’s Guide

How to Contact TIBCO Support

Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

o For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support website.

o For creating a Support case, you must have a valid maintenance or support contract with TIBCO. You
also need a user name and password to log in to TIBCO Support website. If you do not have a user
name, you can request one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to
TIBCO Community.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS
OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER
LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE
SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH
SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE
LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT IS
SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE
ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this document
may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix BusinessWorks, Business Studio, and TIBCO
Business Studio are either registered trademarks or trademarks of TIBCO Software Inc. in the United States
and/or other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its
affiliates.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system platforms
for a specific software version are released at the same time. Please see the readme.txt file for the availability
of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL
BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED
IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING
BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 1999-2021. TIBCO Software Inc. All Rights Reserved.
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